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GeoVista

Introduction

This chapter describes the contents of the GeoVista™ package and describes
the hardware and software requirements. You will find the following sections:

Operating Systems and Hardware Requirements
About the GeoVista Applications
About the GeoVista Documentation

Distribution and Support

11



Introduction Operating Systems and Hardware Requirements

1.1 Operating Systems and Hardware Requirements

GeoVista 4.0 is available on PC/Linux 2.4 and Linux 2.6 operating systems. It
requires 24-plane screens. Terminals with 256 colors are not supported. Use
the xdpyinfo command to check this information.

If you are using XPS or SDS, Geocluster processing software release 1.1 or
above is mandatory. If you are using XPS version 2.2 or SDS version 2.4,
Geocluster release 3.1 is mandatory.

A PC with a Pentium 4 processor or higher is required. You need at least a
graphical card Nvdia-GE-force4, with 1 GB RAM for Linux 2.4. All modern
3D NVIDIA quadro Fx cards operate correctly. Other graphical cards may
work but have not been tested.

The following Linux distributions are supported:

e Linux Red Hat 7.3
¢ Red Had Enterprise 3 (2.4 kernel)
¢ Red Had Enterprise 4 (2.6 kernel)

The OpenMotif 2.2.x runtime package is required. It is recommended to install
the latest patch available from Red Hat support (for example,
openmotif-2.2.3-9 or RH-EL4). This runtime package may coexist with an
existing former OpenMotif runtime distribution, for example package
openmotif21-2.1.30-11 or RH-EL4). To force package installation in this case,
use the - -force and - -no-deps command line options of rpm.

ShowViz requires the GLX extension of the X11 server and an Open-GL
capable hardware with an adequate graphical card and the recommended
drivers. For more information on these issues, contact your local IT support.

Aniwell requires the java virtual machine 1.5 or later to be installed.

NVIDIA drivers must be explicitly installed on Linux boxes. It is recommended
to install the latest stable NVIDIA driver. For more information on these issues,
contact your local IT support.
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1.2 About the GeoVista Applications

The GeoVista package is composed of several applications. These are listed in
the table below:

Application Version Description

GeoVista Launch Pad 4.0 Interface used to access the
applications described below.

VelPicker 1.2.1 Multivolume picking and
interpretation on pre- and post-stack
data.

Vitamin 3.1 Velocity model building (GOM
type).

PetroCaem 1.7.7 Velocity model building (SLT type)

FastQC 3.8.1 Grid manipulation and statistical
filtering.

FastGeoTie 2.7.1 Geostatistical calculations.

VelTracer 321 3D finite offset traveltime
tomography.

Aniwell 11 Well tie and anisotropic velocity
models.
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Introduction About the GeoVista Documentation

1.3 About the GeoVista Documentation

GeoVista documentation is available in PDF format, except the ShowViz
documentation, which is in HTML format and is accessible directly from
ShowViz (formerly called the 3D Viewer).

You can access the documentation from the GeoVista launch pad and from the
main windows of the individual applications.

To read PDF files the acroread executable must be accessible from the user’s
PATH. You can download acroread from the Adobe website:
http://www.adobe.com.
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1.4 Distribution and Support

© CGGVeritas

FLEXIm license manager version 9.5 or above is required. A copy of this
version is provided with the distribution. For more information on this issue,
contact your local IT support.

Send orders for software or licenses to the CGGVeritas software distribution
department:

« email: cgg_distribution.master@cggveritas.com

You need to provide the required number of tokens and identification of your
host(s) depending on your network configuration and contract specifications.
You will receive the 1icense.dat file containing the FLEXIm tokens.
Follow the instructions contained in the CGGVeritas FLEXIm administration
guide and README provided together with CGGVeritas FLEXIm
administration kit in order to install these licenses properly on your site.

For any information, questions, and anomaly reports, contact the Geocluster
user support group:

< email: gvrsupport.master@cggveritas.com

CGGVeritas

Geocluster User Support Group
1, Rue Leon Migaux

91341 Massy Cedex - France
Tel (+33) 164473285

Fax  (+33) 164473413
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GeoVista

New Features

This chapter describes the new features and evolutions of the GeoVista
package. You will find the following sections:

General

Major Changes in the Applications

© CGGVeritas 2-1
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2.1 General

General

Package composition

The following applications have been removed:

DataExchange

All the import/export functions have been incorporated in the Data
Managers in Vitamin and VelPicker.

GvstDataLinker

The data transfer functions with Geocluster have been incorporated in
other applications:

e SLT models: create empty SLT models with PetroCaem.

« Velocity traces: create velocity traces (cst file) in the Data
Manager in Vitamin. Click on External Models on the Velocity
tab and select Export from the popup menu.

« LIBRI GV: export velocity zones created in Vitamin to LIBRI
GV from the Data Manager. Click on Vel. Zone on the PSDM tab
and select Export from the popup menu.

Geomig

This application has been replaced by Vitamin. Five new data types
have been integrated in the Vitamin Data Manager, as well as their
specific Viewer Windows, processes, and interpretation tools: wells,
markers, faults, fault flags, and fault polygons.

The Layer data object replaces the Interval data object. A new process
called "V.Blk to Int" allows you to create velocity interval maps from
vrms cubes.

IsoX

This application has been frozen several years ago and has now been
removed from GeoVista.
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« PSDM Tool

The function for creating Velocity Zones has been transferred to
Vitamin. Select the PSDM tab in the Data Manger.

One new application has been introduced:
*  Aniwell

This application is used to set the anisotropy parameters for each layer
of an SLT model. It requires the following input data: CIP gathers (4D
seismic data), SLT model, at least one well and the well markers for the
boundaries of the layer(s) to update. The Thomsen parameter delta is set
by tying to well markers; epsilon is set by flatening the far offsets of CIP
gathers. The output are delta, epsilon traces, and the interval velocity
traces that ensure short spread focusing in the anisotropic model.

As the number of applications has decreased, they have been gathered into a
single launch pad window.

Palette edition

The Palette tool is no longer launched together with GeoVista. You can open
it to modify and edit your palettes from the Tools menu in the launch pad.

GeoVista stores palettes within a hidden directory:
~/.palette/palettes

The first time you open GeoVista, the application creates this directory and
copies the standard palettes to it. It is recommended to put your personnal
customized palettes there, so they are available directly from the GEM
applications.

The following formats are handled by gem applications:

e .pal:
This is the default GEM format. You can customize them using the
application Palette.

e .cmp
This is the default for Ytools
e .gimp
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Note:
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Color editor

General

The color editor allows you to customize the color palette used to set the
horizon color attribute. To open it, select Tools > Color Editor. The following

dialog box opens:

B =~ colorselectorDemo

259

(=[=]=]

[ 0

. Color List. 4 Color Sliders

I G| otor| Color]
Color| Color| GaIéi| Color]
G616 [Gaier] Color| cotor|
Color] Color| Color| G
Color| Color| [GBIGH| Color|

To make a new color available:

1. Select a color using the Color list or the RGB color sliders (left panel).

2. Click on the color box you to want to modify (right panel).

3. Click on Save. The new color is now available in Vitamin, VelPicker, and

SO on.

This does not modify the color of the horizons and surfaces you already set.
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SLTIib

The standard SLTIlib level is 1.3. However VelTracer uses a more recent
version, SLTIlib1.3patchl, to fix some minor bugs.

Some temporary SLT pseudo-models are created during Vitamin and
Veltracer working sessions, with names that are identical to the VTPCC
model. They are called "pseudo” because they do not contain any data. When
an application crashes, they may be not properly removed and remain in the
SLT database. You can remove them manually. The generic names of the SLT
pseudo-models may be Gom. s

or Gom_[GeoVista project name]@[VTPCC model name].S.

Dip files

The definition of dips in the form of .cst files follows the conventions of the
DIPCA module, UNIT format, in Vitamin and VelTracer. However, you can
use the UNITLESS format as input, as the DIPCA module sets a header word
with a format flag. If this format flag is not recognized, a warning is emitted
and the UNIT format is used as default.
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Major Changes in the Applications

2.2 Major Changes in the Applications

2.2.1 Launch pad

When a new project is created, the GOM database is automatically created as

well.

The new Tools menu  contains the palette editor and the color editor (see
"Color editor" on page 2-4).

2.2.2 ShowViz 2.5

ShowViz is integrated in Vitamin and VelTracer. This release is based on
VolumeViz 6.0 from Mercury and offers two major improvements with
respect to the previous release:

The resolution of ShowViz for data density display is now equivalent to
or better than the resolution obtained in other 2D Viewer Windows. The
display of attributes with narrow data ranges is now possible and uses
the full color palette for 3D textures (that is, 256 colors). As a
consequence, ShowViz 2.5 can be used to display any attribute, not only
amplitudes.

Various enhancements are making ShowViz much faster to obtain full
resolution images when slicing along one given direction.

In addition to these improvements, the following features were added in
ShowViz 2.5:

The Bump Maps display type was added: this is particularly useful
when looking at time slices, since it adds a stereoscopic effect to the flat
visualization mode and allows a better understanding of data variations
is certain areas.

Random lines can be created, interactively picked, and modified from a
ShowViz 3D view. The base can be displayed to help pick the
appropriate locations for the random lines. Any number of random lines
can be created and visualized in this manner.
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Random lines are created for quality control purposes only; they cannot be
saved for further reuse.

* You can change the view angle in ShowViz to automatically adopt a
viewpoint orthogonal to an inline, crossline, or horizontal section. This
is activated in selection mode by keyboard shortcuts i , x , and z when
the mouse is over the displayed volume.

« Option to enable/disable the spinning animation feature of the viewer.

2.2.3 VelPicker 1.2.1

New features

Session and preference mechanisms have been implemented.

Corrected anomalies

Some 4D Display bugs have been fixed, for example:
 the top display area was larger than the others
» Clear Projection function

The bug in the Polyscan process has been fixed.

Various bugs regarding the update of data objects have been fixed.

2.2.4 Vitamin 3.1

New features

Documentation

The User Guide, accessible from the Help menu (Help On Item), provides
information on data objects and processes used for velocity model building.

The Reference Guide provides information on all functions available in
Vitamin.

CGGVeritas 2-7
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Major Changes in the Applications

The Reference Guide is currently available as a provisional version.

Data Manager

The design of the Data Manager has been improved. It has more than two
columns and you can enlarge it to the required dimensions.

You can create a Velocity Zone data object in the new PSDM tab. The Create
function has been improved with respect to the PSDM Tool application. You
can export a Velocity Zone as a LIBRI GV.

You can create a random line and edit it as required in the Data Manager.

TTI anisotropy

You can set the TTI anisotropy parameter of any layer. See the Vitamin User
Guide available from the Help menu.

The TTI tilt axis is defined either by inline, crossline dip cst files (DIPCA
output, migration input) or by nx, ny CCBS files (velocity models). Vitamin
converts between these two types of representation.

Always create the nx, ny CCBS using the Modify Layer: A+ function. Click on
Layer on the Velocity tab in the Data Manager in Vitamin. Select the Layer you
want to modify and select Modify Layer from the popup menu. Never use the
CCBS Create process.

The default format for dip cst files is units. However, the input unitless format
is recognized. The PSDM_314 module suite accepts only the unitless format.
See the User Guide for more details.

A TTI Vitamin model can be exported to a VTPCC or SLT model. It cannot
be exported as a cst file.

The export of SLT and VTPCC models to cst files gives non-interpolated
values of epsilon and delta, contrary to the case of interval velocity, which
must preserve the vertical traveltimes.

Creating CCBS

An option has been added to create a CCBS from a cst file.
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The CCBS parameters are saved in the comments attached to the smooth
velocity cube data object, and are displayed by selecting History in the popup
menu.

Other

The functions for importing cst files have been updated.

Functions for exporting horizons to XPS, creating empty seismic data blocks,
and deleting seismic data blocks have been integrated.

The information window for VTPCC and SLT models has been improved.

Corrected anomalies

Creating CCBS

You can now decimate vertically the input when you create a CCBS. The
process now proceeds in the slowness domain rather than in the velocity
domain. There is no longer a discrepancy when you create a CCBS cube from
a cst file, an inrimage cube (internal Vitamin format), or a layer.

In the Create CCBS Block process, there was a mismatch between the
description of the topo of the block, where the step unit in inline and crossline
was defined in number of traces, and the description of Gaussian Parameters,
where the units were defined in meters. This was confusing for new users of
Vitamin.

Others

Several situations caused the application to crash. These have been fixed.

Heteregeneous behavior of processes and other aspects of the application have
been made more uniform (for example, the Reset button, Quit keyboard
shortcut, labels, topography display, and so on).

A few bugs concerning the update of lists have been fixed.
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2.2.5 Petrocaem 1.7.7

Corrected anomalies

The SLTIib has been modified, such a way that PetroCaem can now write in
the new SLT model format. PetroCaem now writes SLT models in the new
format.

See the PetroCaem limitation in "PetroCaem 1.7.7" on page 4-3.

2.2.6 FastQC 3.8.1

New features

User preferences: a preference file ~/.fastqc is created and updated each time
you quit FastQC. This file contains information concerning the size of all
graphic windows, and the symbol and size of dots in scattered dataset displays.
See the new options Main Window Size in the Main Window and
View > Point Style in the 2D Display Window.

The Tools > History option in the Main Window provides information on all
data objects, even those calculated in the 2D Display Window.

A new function for importing seismic data is available in the Main Window.

New gridding methods have been implemented: Gridding Window, -Min,
Max, and Min-Max.

The algorithm used by the Processing > Grids > Contouring menu option
(Main Window and 2D Display Window) has been changed. Moreover, it has
two new options:

» you can select the number of decimal digits for the labels

« you can choose to compute the contour points without interpolation or
select a large, medium, or small step for the interpolation (Smooth
Grade option).

2-10
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In the Main Window and the 2D Display Window, the new option Processing
> Scattered datasets > Statistical Operations allows you to create a new
scattered dataset from another one (or a part of another one if displayed in the
2D Display Window), with conditions for the keys.

The algorithm used by the Processing > Back sampling option (Main Window
and 2D Display Window) has been changed. It also contains a new option for
selecting either a bicubic or bilinear interpolation.

In the 2D Display Window, the Create > Scattered Dataset > from Selection
option contains a new feature that allows you to discard points with z equals
to the non-value.

You can add a second logo to the Plot (2D Display Window, Data > Plot
menu). In the Layout section you can create, modify, and delete text boxes.
You can define a Display Name in the Select > Scattered Dataset Attributes
option. In the 2D Display Window, you can set the Legend window according
to the interval defined in the Visible Values area (button Real Value Bounds).

In the 2D Display Window, the window that opens when you select
View > Composition contains an option for displaying contour sets with or
without labels. This options is available only if the contour set was computed
with labels.

2.2.7 VelTracer 3.2.1

New features

The user documentation has been grouped into a single document, accessible
by selecting the Help > On Application menu option.

Several processes are now "batch" type, allowing you to work whilst they are
runing.

Some new features have been implemented to keep user preferences: survey
grid setting, IL/XL selection, and so on.

QC RMO: The RMO used for inversion job QC is now computed using a
parabolic fit, at the actual maximum offset. The actual maximum offset mainly
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Major Changes in the Applications

depends on POSTMUTE (in the case of HDRES), plus the aperture inversion
parameter. In previous versions, VTPCC used a parabolic fit, but VelTracer
Mono did not; and the RMO was always computed at the reference offset for
both VelTracer Mono and VTPCC, creating non-geophysical, large RMO
values in the near surface.

VTPCC model lists has been modifed: the GoM database name no longer
appears.

Objects have been separated to two groups: one for VelTracer Mono and the
other for VTPCC.

The function Export to cst has been split in two:

» Export to cst Files

e Export to Seismic 3D Files

VelTracer Mono
In Velocity Field Parameters Setting, the following options have been added:
e Estimating Vv
» Estimating epsilon
» Keep Well-Tie
The Grid Definition Setting no longer depends on the Keep Background
option. The grid extent and origin are automatically set according to the initial

model. You can modify either the mesh size or the number of nodes. The other
parameters are automatically computed.

The parameter maxParams that defines the RAM to be used by the inversion
is obsolete, as memory use is computed automatically.

The listing has been modified. Mean and standard deviations of RMO are now
printed.

If the traveltime of RMO picks inside the layer to update is lower than 20 ms,
the RMO picks are automatically rejected (minTimelnLastLayer option,
default=20 rather than 0). The rays can now be partly inside, partly outside the
CCBS grid.
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A new QC attribute has been introduced: mean smearing of kinemig.

VelTracer PCC

The data object Pcclnvariants is included in the Data Manager and in the
PcclnversionJob Create function. It manages the RMO invariant data created
in the Beyond Dix workflow (output file from KDMIG).

The default quality factor for PccRMOCurves is set to 50. If you set the quality
factor by a cst file, the data range is checked and may be scaled by 100 (case
HDRES semblance) in such a way that the values saved in the PccRMOCurves
are in the range 3 to 100. The PccRMOCurves which quality factor is smaller
than 3 are removed.

The RMO picks with an external mute (case HDRES POSTMUTE) that is
smaller than the minimum offset (Definition of Offset Classes parameter) are
removed. The offset parameters (min/max/inc) are checked and adjusted if
needed.

The default parameters of PcclnversionJob are the same as for VTPCC40. The
modifications are saved when you use the Next or Previous button.

TTI
The vertical dip (degree) of the TTI axis can be displayed and exported.

The INL and CRL dips of the TTI axis are displayed and exported using the
unit format. There are scaled by 100, except when exported to cst files.

Viewers

The survey grid can be set using the Velocity Zone data object (Image Zone).

The default IL/XL increments (Sections tab) are computed such a way that the
list is entirely contained in the dialog box. If you change them (Sampling tab),
the new values are retained as well as your selection, and everything is kept in
your user-preferences.

The PccRMOCurves are now directly accessible from the Viewer Windows,
so you no longer need to reformat them to RMOCurves data objects. The RMO
picks display can be customized in various ways.
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The thickness of the QC scatter chunk used to select the RMO (or other QC
attribute) to display is now independant of the IL/XL increments (Sampling
tab).

Corrected anomalies

Several situations caused the application to crash. These have been fixed.

In the SLT Models list in the Data Manager, in the Set/Edit Anisotropy
Parameters option, the tilt setting depended on the setting of epsilon/delta.

Several bugs concerning the update of lists have been fixed.
The header word 19 (line number) in exported cst files was wrong and has

been corrected.

VelTracer Mono

Closed Gocad surfaces (typically salt) are better handled and error messages
are fixed.

Inversion jobs: in the Edit/Submit function, some modified parameters were
not saved. The function Set Bspline Velocity Parameters (2D or 3D) For All
Layers did not use user-defined values.

There was a minor error in TTI elliptic ray-tracing: the spatial gradient of tilt
was not considered. This has not affected any project as Vitamin always sets
TTI_Thomsen flag (and not TTI_Elliptic) as soon as tilt is assigned to the
velocity model.

The precision of kinemig smearing (and consequently of Frechet derivatives)
is improved: half rays are no longer welded.

The precision of QC RMO and gamma attributes is improved.

The automatic padding of last slice of CCBS grids has been removed as this
function was a workaround to a Vitamin bug that is now fixed.

Automatic densification of CCBS grids at end of inversion when the
keepBackGroundDv option is chosen now occurs when the ratio between
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sampling intervals of V and DV grids is less than or equal to 2. It used to be
less than 3.

The Keep Ties option coded using the parameter keepTies:True [False per
default] allows you to estimate delta(x,y,z) instead of V(x,y,z). The purpose is
to perform short-spread focusing by maintaining well ties. "Depthing" must
have been performed beforehand. In the STI context (TTI case where tilt axis
is orthogonal to the geological structure), positioning in the zero-offset image
will not be affected by re-focusing using the delta Thomsen parameter. If you
select this option, provided velocity grid parameters will apply to the delta grid
instead. Regularization and standard deviation parameters are equal to those
assigned to a velocity field (in m/s units). However, the filterV optional
parameters must now be given in delta units.

Inversion was not applying regularization to chunks having no RMO data.

Resizing of grids now produces the same results in 32bits and 64bits.

VelTracer PCC

PccRMOCurves: in versions 3.0.3 to 3.1.3, the local dip associated with RMO
picks (DIPCA cst file) was miscalculated.

In Pccinvob, some parameter values were lost or changed after reloading. The
default COST_FC value was 3 instead of 1. It is easier to modify the final
model name.

TTI

The export of SLT and VTPCC models to cst files no longer interpolates the
epsilon and delta values, contrary to the case of interval velocity, which must
preserve the vertical traveltimes.

Viewer Windows

A few Viewer Windows had a "hard-constrained" maximum depth at 5000m
(SAR 14204).

The inversion QC now correctly displays the RMO curves when there more
than 8 views.
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In the Velocity Section Viewer Window, the gamma section is no longer
displayed by default.
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Installation and Licences

This chapter describes how to install GeoVista and provides information on
the required licences. You will find the following sections:

General
Installing GeoVista
License Management

Starting GeoVista

© CGGVeritas 31



Installation and Licences General

3.1 General

Before you start installing the GeoVista software, please refer to "Operating
Systems and Hardware Requirements” on page 1-2.

The GeoVista installation directory must be accessible from the machine on
which GeoVista is installed. Throughout this chapter, all examples refer to the
following GeoVista installation directory:

/softs/instal dir

The GeoVista software distribution package is distributed on one CD-ROM
which contains the software as well as instructions to install and use GeoVista
version 4.0 on PC-Linux platforms.

GeoVista can be fully installed in read-only directories.

3-2
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3.2 Installing GeoVista

The CD-ROM Gvst4.0 contains the following files:

« acompressed archive file containing the GeoVista software
(distrib-gvst-4.0.tgz)

» acompressed archive file containing the FlexLm license manager
(FLEXIm_95.tg2)

« one copy of the FLEXIm9.5 Administration Guide (FlexIm.pdf)

« one copy of the Release Notes (present document) and GeoVista
Overview.

 one copy of the ReadMe file containing information and procedures for
transferring files from the CD-ROM to your system.

Follow the procedure below to transfer the files from the CD-ROM to your
system.

The examples given throughout this section assume that the GeoVista
package is to be installed under the install dir directory on a PC/Linux
machine correctly configured (see Chapter 1,"Introduction”).

1. Login and move to the directory in which you want to install the software.

2. It is recommended you be logged in as super-user even though this is not
mandatory. However, you must have write permissions for the directory in
which the software is to be installed.

3. Check the available disk space of your system: you will need
approximately 1.6 Gbyte to install GeoVista on Linux 2.4 and Linux2.6.
Use the following command to view the available disk space in kbytes:

df -k
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Installing GeoVista

4. Check that the gzip utility software is installed and declared in your path.
If this utility is not available on your site, it can be downloaded from the
following websites:

http:// www.gzip.org
http:// www.gnu.org

5. Mount the CD-ROM device (if it is not already mounted) and move to the
installation directory:

o\°

mount /[CDROM path] (Linux system)

o\°

cd /softs/instal dir
% umask 022

6. Insert the CD-ROM Gvst4.0 and enter the following command to
uncompress and unarchive (single command) the distribution in the
installation directory:

gunzip -c < /[CDROM path]/distrib-gvst-4.0.tgz |
tar xvf -

If you are working on a SUN platform, you must unarchive using the "i" option
(xvfi) of the tar command.

As a result, you will retrieve a directory named distrib-gvst-4.0

7. Change the owner and distribution group if necessary: if you installed the
CD-ROM on disk as root, the owner and group of the distribution must be
modified to accommodate existing users and groups on the installation site:

)

% chown -R my owner:my group distrib-gvst-4.0

Where my owner and my group are respectively the owner and group
suitable for your site.
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3.3 License Management

GeoVista licenses are managed by FLEXIm, the license manager delivered
with the GeoVista package.

The purpose of this section is to provide site administrators who have no
knowledge of FLEXIm administration, with a basic set of principles regarding:

» the FLEXIm components,
» procedures to administrate FLEXIm licenses.

For advanced information on FLEXIm administration, site administrators can
refer to the FLEXIm End User Manual provided by Globetrotter.

This section describes only the major features of FLEXIm and does not
discuss multiple license servers (redundant servers).

3.3.1 FLEXIm Main Components

FLEXIm includes the following components:
 license manager daemon
« vendor daemon
e administration tools

* license file

License Manager Daemon

The license manager daemon is a program called 1mgrd (refer to
"Administration Tools" on page 3-6). This program is responsible for
establishing the connection between an application requesting a license and
the appropriate vendor daemon (refer to "Vendor Daemon" on page 3-6).
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Vendor Daemon

This program is provided by the software vendor and allows you to grant
licenses for applications. Only one vendor daemon of a given type must be
running at a time on a given host. The name of the vendor daemon is specified
in the license file (refer to "License File" on page 3-8). The name of the
daemon used for CGGVeritas products is cggf lexd.

Administration Tools

Only the most important commands are described in this section. Refer to the
FLEXIm End User Manual for additional information.

lmgrd [-c license-file]l [-2 -p]

This command runs the license manager daemon (refer to “License Manager
Daemon" on page 3-5) in background mode. The following options are
important:

[-c license-file]

This option defines the location of the license file to be read. For a simple
configuration, this command assumes that you run only one 1mgrd dae-
mon per machine. (However, multiple server programs can be launched
from the same machine, although this is not recommended.)

After changing the location of the license file, you can use the lmreread
command.

[-2 -pl

This option disables the 1mdown, 1mremove, and 1mreread com-
mands for all users other than root or members of the 1madmin UNIX
group, if it exists.

Imdown [-c¢ license-file] [-vendor vendor-name]

This command shuts down the license daemons. If the -vendor option is
specified, only the vendor daemon named vendor -name is shut down. If the
-vendor option is not coded, all vendor daemon programs and 1mgrd itself
are shut down.
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Imdiag [-c license-file] [feature]

This command is used to identify, for a given feature, potential problems that
can occur in licence file management. It allows you to trace specific errors
when requesting a license. When the license check out fails to provide the
minimum necessary information, use this command. If no feature is specified,
all features within the licence file are scanned.

Imreread [-c license-file] [-vendor vendor-name]

This command allows the license manager daemon (1mgrd) to reread the
license file and start any new daemons that have been added to the file. It also
allows the license manager daemon to take into account new features added to
a given vendor daemon. Note that this command cannot be used to change the
server node or modify port numbers (in both cases, use the 1mdown command
first). If option -c isused, the 1icense-file is read, otherwise 1mgrd
rereads the file with which it was initially launched (this is the most frequent
case).

lmstat [-a] [-A] [-c license-file] [-f feature-name]
This command is used to monitor network license activity. Refer to the
FLEXIm End User Manual for a complete list of options and their description.
The most frequently used options are:

-a
Display all information,

-A
List active licenses (that is, licences in use),

-c¢ license-file
Use the license file named 1icense-file,

-f feature-name
List all users of the feature named feature-name

For more information on how to install and run these utilities, refer to the
FLEXIm End User Manual. Since backward compatibility is guaranteed, it is
recommended to install and use the most recent set of FLEXIm administration
tools.
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License File

The license file stores information on server nodes, vendor daemons, and
features. Each line of this file starts with a specific tag. The most common tags
are described below:

SERVER

This tag specifies the node name (host name), hostid and port number of
the license server on a server. The port number must be edited and updated
with a free port number on the server machine (for example, 1300, 1700,
and so on).

VENDOR

This tag defines a given vendor daemon. For example, the location of the
cggflexd executable (for CGGVeritas products) must be placed here. The
command line might be as follows:

VENDOR cggflexd /usr/local/bin/cggflexd

FEATURE

This tag describes a license for a given product. The reaTure lines may be
split into several lines in the license file. In this case, each line except the
last one must end with the \ character. For further details, refer to the
FLEXIm End User Manual.

3.3.2 Basic FLEXIm Administration

For a complete understanding of FLEXIm, you are strongly advised to follow
an adequate training session.

This section provides a basic overview of FLEXIm administration. You will
find information on the following topics:

¢ General Advice
e FLEXIm Tools

 Starting the License Server
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« Using the License File

General Advice

The main advice as a basic principle is to "KEEP IT SIMPLE". You are
strongly advised to follow these rules:

¢ Install the FLEXIm administration package on each machine that will
act as a license server (refer to "FLEXIm Tools" on page 3-9),

» Start the 1mgrda program at boot time. This allows the use of the license
immediately after the machine has restarted without any other
intervention,

« Create only one license file per license server. In the most simple
configuration, the license server is also the machine on which the
applications are run,

» Specify the location of the license for your end users in the default
/etc/profileand /etc/.login files. In this manner, the end
users do not need to search everywhere for licenses.

If you follow these basic indications for novice administrators, you should not
encounter any major problems using FLEXIm.

FLEXIm Tools

The following components must be installed locally on each license server in
the required location:

* Administration tools described above (see "Administration Tools" on
page 3-6),

e Licence manager daemon (1mgrd),
« Vendor daemons (cggf lexd for CGGVeritas products),

For example, you can install these elements in directories /opt/Flexlm,
/usr/local/bin, and so on.

Make sure that you install the most recent FLEXIm tools (they are backward
compatible with older tools).
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The former vendor program used for CGGVeritas products is petrosysd,
and some licenses may require this daemon. You may safely install the new
vendor daemon, cggflexd, and run both at the same time. However, new
CGG\Veritas licenses only use the cggflexd program.

Starting the License Server

The 1mgrd program must be run with the location of the license file on each
license server. To insure that the license server is always running, it is
recommended to run this program at boot time, for example, by adding the
following lines to the appropriate /etc/rc2.d/Sxxxx initialization file:

#/sbin/sh
case "$1" in
'start' ) if [ ! -f /usr/local/etc/license.dat ] ; then
echo 'cannot find license file'
exit 1
fi
[ -x /usr/local/bin/lmgrd ] || exit 1
nohup /usr/local/bin/lmgrd -c /usr/local/etc/
license.dat > /dev/null 2>&l1
'stop' ) [ -x /usr/local/bin/lmdown ] || exit 1
echo y | /usr/local/bin/lmdown

r

esac

Since boot files are executed in Bourne (sh) shell, do not use C-shell syntax
in these command lines.
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Using the License File

This section provides information on the location of the licence file as well as
further recommendations.

Location

The location of the license file (usually 1icense.dat) must be defined by
the LM _LICENSE_FILE environment variable. When several locations are
defined, this variable refers to a set of paths separated by colons (as for a UNIX
PATH variable).

Two different options are available to define the location of the licence file:

1. The path is the complete file path.
For example:
/usr/local/etc/license.dat.

This is the simplest solution, in which case the license servers are isolated
from each other. This requires that you request and install a license for each
machine on which the applications are supposed to run.

2. The pathis: port@host, where port and host are respectively the port
number and host name of the machine on which the license server is
running. This type of path is used when a specific machine acts as a license
server regardless of the machine from which the applications may be run.

The choice to use one or the other of these configurations depends on your site
and the way in which you intend to administrate licenses.

The first option is the simplest one: it is used if you do not want floating
licenses and you intend to order one license file for each machine running the
applications. However, it is possible to use floating licenses with this
configuration.

The second option indicates that you intend to make a distinction (at least in
theory) between the machines that will serve the licenses and those on which
the applications will be run.

In either case, simplify the procedure for the users and define the location of
the license in the default login shells (refer to "Location” on page 3-11).
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Recommendations

Define only one server per license file and check that each vendor daemon is
present only once. Of course, several vendor daemons with different names
may be found in this file. Organize clearly the contents of your file (using any
ASCII text editor) to group all features using the same vendor daemon.

Check that the FEATURE lines are not duplicated in the file: each feature must
be present only once. If users need to have access to two different versions of
the application (for example, during a period of beta-test for a new version of
a program), keep the FEATURE line with the higher version number or install
the new license on a dedicated license server.

3.3.3 Ordering and Installing FLEXIm licenses and the
Geocluster key

The GeoVista 4.0 package includes the following applications:

ShowViz 2.5
VelPicker 1.2
Vitamin 3.1
PetroCaem 1.7
FastQC 3.8
FastGeoTie 2.7
VelTracer 3.2

Aniwell 1.1 does not need a licence.

GeoVista 4.0 uses FLEXIm licensing. To obtain the license file for the re-
lease, send the following information to the CGGVeritas distribution de-
partment:

The hostname and hostid of the machine used as a license server.
To obtain this information, use command 1mhostidonaUNIX server
or Imvdh on a Linux server.

The number of licenses that you intend to use simultaneously.
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In return, you will receive the 1icense.dat file containing the FLEXIm
tokens. To install these licenses on your site, follow the instructions described
in the CGGVeritas FLEXIm Administration Guide and the README file
provided with the CGGVeritas FLEXIm administration kit.

For any remaining problems during or after the installation, contact the
GeoVista User Support group at:

CGGVeritas

Geocluster User Support Group

1, Rue Leon Migaux

91341 Massy Cedex

France

Tel: 33164 47 3285

Fax: 33164 47 34 13

e-mail: gvrsupport.master@cggveritas.com
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3.4 Starting GeoVista

You can launch GeoVista directly from the Geopad application by selecting
option Applis>GeoVista-4.0 in the Geopad main window. In this case, the
program automatically accesses your GeoVista project database.

If GeoVista is not available from Geopad, contact your site administrator or
follow the instructions described below.

Setting the Project path

The GeoVista applications need a studies file to obtain the list and
definitions of the various GeoVista projects. By default, the studies file is
defined either directly in your home directory (~/ .studies) orin the sub-
directory ~/ .gem/studies.

To allow several users to work on the same projects, you must set the Unix
environment variable GEM_STUDIES as defined below:

setenv GEM STUDIES /usr/local/etc/all studies in C-shell
export GEM_STUDIES=/usr/local/etc/all studies in Korn shell

This setting can be defined in your . 1login file and will be automatically run
when you login.

Starting GeoVista

1. Open an xterm window and login as a regular user.

2. Enter the following command:
% /softs/instal dir/distrib-gvst-4.0/bin/GeoVista &
where

/softs/install dir is the directory where the package has been in-
stalled.

3. The GeoVista shell-script calls up the GeoVista launchpad with all
applications ready to run.
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Removing Core Files Automatically

When a program crashes, the operating system generates an information file,
usually called core (under Linux, it is called core.pid, where pid is the
process ID). These files are usually large files (several Mbytes). To prevent the
system from generating these files, add the following line to your user
environment files (for example, the . 1ogin file).

In C shell:
limit coredumpsize O
In Bourne shell:

ulimit -c O
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GeoVista

Known Problems and Limitations

This section provides a list of the known problems in the current version of
GeoVista. You will find the following sections:

4.1 ShowViz 2.5

On Linux2.6 systems only, the display of data blocks (converted to the LDM
format) in ShowViz can be incorrect if their geometry is very irregular (many
more inlines than crosslines or vice versa).

On Red Hat 3.5 (RHEL) platforms, ShowViz may sometimes be unstable.

When you drop a data block for 3D visualization in ShowViz, the LMD
formatted block is not recomputed if the original block has changed. It must
be explicitly deleted by the user.

4.2 Launch pad 4.0

As a consequence of the gathering of all applications into one single tab, the
applications you added yourself may be hidden in the GeoVista4.0 launch pad
display. To recover these applications, follow these instructions:

1. Edit the following file:
~/ .GVDestops/DATA/GmDesktop/user default/user default.desc

2. Remove all your personal applications from the following lines:

InversionTools=appl, app2,
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Vitamin 3.1

InterpretationTools=app3, app4

PsdmTools= app5, appé6

3. Then add your personal applications to the following line:

DataManagement=app0, appl, app2, app3, app4, appr5, app6

4. Re-launch GeoVista4.0 for the modification to be taken into account.

4.3 Vitamin 3.1

There are some limitations due to differences between the SLT, VTPCC, and
Vitamin model formats. Refer to the Vitamin 3.1 Reference Guide for further
details.

CCBS Create: do not use the option Create from Model (known bug).

Notes on TTI anisotropy

The anisotropy parameters cannot be set when creating a Layer.
First, you must create the layer, then select option Modify Layer from
the popup menu.

TTI Anisotropy is not fully handled by the Vitamin model: you cannot
export TTI anisotropic Vitamin models to cst format files. Instead, use
option VTPCC/SLT export.

Dip cst files are exported in units format. Be advised that the travel time
computation modules in patch PSDM314 still uses the unitless format.

Faults, fault flags and fault polygons have been introduced in their
native formats in the common GEM framework.

When you export the model to cst format traces, you must always set the
output trace format to 32-bit rather than 16-bit (as the default is 16-bit).

Note that the Vitamin 3.1 Reference Guide is not yet available.
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4.4 PetroCaem 1.7.7

When you select property data, the last attribute calculated using the datapack
calculator is displayed by default. To choose another attribute, use the
histogram or colormap editor of the datapack calculator.

When you add a horizon or modify a boundary without modifying the layer
velocity within a SLT model, you may face problems due to limitations of
PetroCaem. The main occurrences are described here after, with the
appropriate work around.

CCBS

The CCBS contained within a SLT model are transformed to Property models
while they are imported. This is very useful for QC purposes. However, you
are advised not to recompute these CCBS while exporting the SLT model,
because this implies modification (smoothing at least).

The appropriate workaround solution is as follows:

1. Import the model and modify the horizon/layer boundary,

2. Export the modified model by defining the layer velocity by any velocity
function,

3. Copy the CCBS from the original model (OMod) to the modified model
(MMod) by using the following command lines:

cd /my_ GeoVista project path/MyGeoVista Project.DB.SLT.S/geology.S/
cp OMod.S/OMod_version.S/vfield.S/LayerName.S/v3.S \
MMod.S/MMod_version.S/vfield.S/LayerName.S/v3.S

For further details, refer to section "Structure of the SLT model” of the
Veltracer 3.2 Quick Reference Guide available from the Veltracer online help.

If the layer velocity is equal to VO+kz+CCBS (which usually comes from a 3D
update of a VO+kz layer), the CCBS is not imported (PetroCaem limitation).
In this case, proceed as explained above and copy manually the original CCBS
to the new model.
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Anisotropic SLT models

Anisotropic SLT models cannot be read by PetroCaem (PetroCaem
limitation). However, you can modify horizons and layer boundaries as well
as export the modified model as an isotropic model. You must then copy the
anisotropic parameters from the original model to the modified model. Finally,
modify the file s1tmodel . s according to the instructions described in the
PetroCaem 1.7 Release Notes available in the on-line help.

4.5 FastGeoTie 2.7

Be advised that there is no automatic variogram available for UTM
coordinates.

4.6 VelTracer 3.2.1

The drag and drop operations between the Data Manager and Viewer
Windows are only partially available.

You cannot select data interactively in the Viewer Windows. For example, you
cannot choose the location of a vertical section on a velocity model by clicking
on a velocity map display.

By default, the unit of length is meters and all parameter values are therefore
expressed in meters. If the unit of length of your project is feet, you must
multiply the values expressed in meters by three.

The exported dip cst files are in units format. Be advised that the travel time
computation modules in patch PSDM314 still uses the unitless format instead.

The VelTracer user documentation is not yet available.
For any queries, please contact the CGGVeritas support department
(email: gvrsupport.master@cggveritas.com).
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